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Preparing the Data

In previous versions of ArcMap, there existed an option to specify a “no data” value. Since all of
the missing values found in the point data (ie. 1998 _Ont_pts.shp) are labeled as -1, this option
allowed for the exclusion of such points from the interpolation. However, in ArcMap 10, this
option no longer exists. If a kriging model is run, it will include all the values of a variable,
counting the missing data as -1, and will produce skewed results. Therefore, this data needs to
be modified, and the missing values must be removed from the dataset prior to being imported

into ArcMap.

Open Microsoft Excel, and click File = Open. Find the source file where the point data is
located. At the bottom right of the “Open” window, ensure that “dBase Files (*.dbf)” is selected.
Double click the .dbf file of the point data to open it.

To identify all of the cells that have missing values of -1, hit Ctrl+F on the keyboard. This will
open the “Find and Replace” window. Click the Replace tab at the top. Type “-1” into the “Find
what:” box. Leave the “Replace with:” box empty so that the cells that have a value of -1 will
become blank. Click Find All, and this will show all of the cells that have been identified. Click
Replace All, and all of the cells that previously had a value of -1 will now be blank. Click

“Close”.

Find and Replace @
Find Replace
Find what; -1 |Z|
Replace with: |Z|
| Cipkions == |
R ______ eplace&ll _______ ] | Replace | | Find &ll | | Find Mext | | Close |
Biook. Sheet Mamme  Cell Yalue  Formula it
1995_0Ont_pts.dbF  1995_Ont_pts $uge E
1995_Ont_pts.dbF 1995 Ont_pts $dd
1995 Ont_pts.dbf 1995 Ont_pts 445
1995 _Ont_pts.dbF 1995 Ont_pts 4§47
1995 _Ont_pts.dbF 1995 Ont_pts 4045
1995 _Ont_pts.dbF 1995 _Ont_pts £¥10
1995 _Ont_pks.dbF 1995 Ont_pts tug12
1995 _Onk_pks.dbF 1995 Ont_pts duk14
1995_0Ont_pts.dbF  1995_Ont_pts $RE16
1995_Ont_pts.dbF 1995 Ont_pts $%$15
L T T D T Sy Spunp | By L T T T s, T MRy S A, 3
74 cellis) found




Click File > Save As, and save the file as a .xIsx to the desired destination with a suitable name
(such as 1998 _Ont_pts_edit). Close Excel.

Open ArcMap. Click the Add Data button and double click the recently altered .xlsx file, and
double click again on the worksheet in which the data is stored (usually the file on top).

Since this is a spreadsheet file with no spatial dimension, it is necessary to create a new shapefile
based on the data within. To do this, click on the ArcToolbox icon, then expand Data
Management Tools = Projections and Transformations, and double click Convert Coordinate
Notation.

ArcToolbaox (=]
ArcToolbox -
@ 3D Analyst Tools

% Snalysis Tools

% Business Analyst Tools
% Cartography Tools

-@ Conwversion Tools

@ Data Interoperability Tools
E% Data Managerment Tools
ﬁ: Data Comparizon
%: Database

- B Distributed Geodatabase
ﬁ: Darmains

ﬁ: Feature Class

ﬁ: Features

- By Fields

- By File Geodatabase

ﬁ: General

ﬁ: Generalization

- & Graph L
- By Indexes

ﬁ: laoins

ﬁ: Lawers and Table Wiews

ﬁ: Package

Eﬁ: Prajections and Transformations

Ej--&: Feature

[

m

----- -, %, Create Spatial Reference

----- *, %, Define Projection

G- B Raster i




Under Input Table, select the modified .xIsx spreadsheet. Under Output Feature Class, specify
the destination, and name the file appropriately. Under X Field (Longitude), select LON, and
under Y Field (Latitude), select LAT. Since the coordinate formats will not be used, Input
Coordinate Format and Output Coordinate Format can be left as default (DD). Under ID, select
STN_, as this will be the field used to later join the spatial data to the .xIsx. Under Spatial
Reference, select the appropriate projection (in this case, NAD_1983 UTM_Zone_17N).

"’E\h Convert Coordinate Motation EI@
Input Table - I
|'1998_Ont_pts§ | I
Cutput Feature Class -

Ssummerwarkikrigingexamplefiles! 1995 _0Ont_pks_edit,shp [,1_’-"1
¥ Field (Longitude)

LOM -
% Field (Lakitude)

LAT -
Input Coordinake Format

DD -
Cutput Coordinate Format

DD L 4
ID {optional)

STH_ -
Spatial Reference {opkional) -

MNAD_1983_UTM_Zane_17N i

Ik ] | Cancel | | Ervironments. ., | | Shaw Help == |
Click “OK”.

A shapefile will be produced from the latitude and longitude coordinates found in the .xlIsx file.
However, upon opening the attribute table for the shapefile, it can be seen that there is no
contaminant data. This can be repaired by right clicking the layer in the Table of Contents,
hovering over Joins and Relates and clicking “Join...” The .xlIsx table should be selected by
default in 2. Under 1., select the field that the join will be based on (STN_ in this example).
This should automatically select the same field in 3. Ensure “Keep all records” is selected.
Before clicking “OK”, the window should look like the following:



i o

Ioin Data @

Join lets vou append additional data to this laver's attribute table so you can,
fFar example, symbalize the layer's Features using this data,

Wehat do wou wank to join to this laver?

Jain aktribukes From a kable -

1. Choose the Field in this laver that the join will be based on:

STH_ -

2. Choose the kable tojoin to this layver, or load the table from disk:

= 1398_0nt_pts M=
| Show the attribute kables of layers in this lisk

3. Choose the feld in the table to base the join on;

STH_ -

Join Cptions
@ keep all records

All records in the target table are shown in the resulting table.
Unmatched records will contain null values far all fields being
appended into the target table From the join kable,

Keep only matching recards

If a record in the target table doesn't have a match in the join
kable, that record is removed From the resulting target kable,

| Walidate Join |

About Joining Data POk { | Cancel |

Click “OK”. Open the attribute table of the shapefile to ensure that the join worked. It should
now display all of the contaminants, and show <Null> where there are missing values. The
shapefile is now ready to be used for Kriging analysis.



Running the Interpolation
In ArcMap:
Add the following layers to the existing layers:

Shoreline vector (ie. realdeal_utm17.shp; Erie-UTM17.shp)
Clip layer (ie. ontario_clip.shp)

O Ui Ak Aol s ]

Fie Ede View Uookmis Insen Telection  Geoprocessing  Customiz: Windows Help
2 i ® " & o 11100 sl EEBE O P 07 5 Gesmbatical Anabuts G 2 = =1 g

N W e i

gx|

S Lagers |
= B0 SSummerWort\brigngeamplenle:
@ 1896 Dt g, et -

= M

SATRAGTAE AN0TAILIAT Meter

The point data contains the data used to perform kriging.

The shoreline vector layer symbology should be “Hollow”
e Click the symbol once in the Table of Contents and click on the “Hollow” option.

The clip layer does not need to be visible as it is not used in the final product.

Select Customize - Toolbars = and ensure that the Geostatistical Analyst extension is active.
Click “Launch Geostatistical Wizard” to open the tool.

Geostatistical Analyst = $|

[ Launch Geostatistical Wizard




Variogram Model Selection

With “Kriging/CoKriging” highlighted under “Methods”, ensure that the “Source Dataset” is the
point data (ie.1998_Ont_pts), and the “Data Field” is the contaminant that you wish to
interpolate (mercury in this case).

Geostatistical Wizard: Kriging £ Cokriging

ethads Input Data

=l Deterministic methods Bl Dataset
Irwerse Distance Weighting Source Dataset 1995_0nt_pts_edit
Global Polynomial Interpolation Diaka Field

1996 _ont_pts$' Hia
Local Palynomial Interpalation

_ | ! El Dataset 2
Radla-l B‘?SIS Functions Saurce Dataset <nang=
- Geostatistical methods B Dataset 3
= = R Source Dataset <Mone =
-l Interpolation with barriers
) Bl Dataset 4
kerrel Smoothing
o Source Dataset <nang:=
Diffusion Kernel

About Kriging / CoKriging

Kriging is an interpolator that can be exact or smoothed depending on the measurement error model. It is very Flexible and allows you bo investigate graphs of
spatial auto- and cross-correlation, Kriging uses statistical models that allow 3 variety of output surfaces incuding predictions, prediction standard errors, probability

and quantile. The Flexibility of kriging can require a lot of decision-making. Kriging assumes the data come Fron a skationary stochastic process, and some methads
assume normally-distributed data,

Learn more about Kriging J Cokrigin

< Back Mexk = ]| Einish | | Cancel

Click “Next.”



Leave everything on the next screen as the defaults:

Kriging Type
Transformation bype

Simple Crder of trend remaowal
Universal

Indicatar
Probability
Disjunctive

Output Type

Cuantile
Probability
Prediction Standard Errar

Click “Next”.



On the next screen, “Geostatistical Wizard - Kriging Step 3 of 5 - Semivariogram/Covariance

Modeling”:

e Under “Model #1”, ensure that Spherical is selected as the Type.

Adjust the “Major Range” to 100,000 by clicking the calculator icon to the right of

the value (which will change to a pencil icon), then typing in the number.

Under “Anisotropy”, select “True”.

characteristics of your points.

Adjust the “Minor Range” to 50,000 in the same manner as the Major Range.
Adjust the “Direction” box to 90 for Lake Ontario, or 70 for Lake Erie.
NOTE: These values are determined through experimentation and the distribution

Geostatistical wizard - Kriging step 3 of 5 - Sernivariogram/Covariance Modeling =) @
Semivariogram E General
1 Opkirize model [
¥-10 variable Semivariogram
2532 . - . * B Model Nugget
7904 . Enable True
Calculate Mugget True
2016 Mugget 0.1005653
Measurement Error 100 o
1.728 B Model #1
1.44 Type Spherical
Major R.ange 100000
1152 Anisotropy True
Minor Range 50000
0864 Direction an
0576 Caloulake Partial Sil True
Partial il 0.0427537
0288 = " Model #2
ey 4 Model #3
a 0877 179 2E32  3A1 4387 RZEB B142 F02 0 789 8774 E Lag
= hiodel ¢ Binned < Averaged Distance [Meter], h-10 -4 Lag Size 7312
todel : 0.10057*Mugget+0.042754S pherical(100000,50000,90.0) Mumnber of Lags 12
D.2592I
- 0216
T
2 01728
=
o
g 01296
£
£ 0.0364
[ix]
nodazg -
|
| % Back H Mext = ] | Einish | | Cancel

These attributes remain the same throughout model testing, which takes place next.

Click “Next”.




In “Geostatistical Wizard - Kriging Step 4 of 5 - Searching Neighborhood”, ensure that:

“Maximum Neighbours” is 5
“Minimum Neighbours” is 1
“Sector Type” is “4 Sectors with 45 degree offset”

your points.

NOTE: These values are determined through experimentation and the distribution of

Geostatistical wizard - Kriging step 4 of 5 - Searching Meighborhood

FacaMQ «=|[HE| -

[rataset

Meighborhood type
Copy from Variogram
Maximurn neighbors
Mimiriunn meighbors
Sector type

= -5l

#0[1995_Ont_pts_e...

El search Neighborhood

Standard

True

)

1

G 4 Sectors wit,,,

Angle a0
Major semiaxis 100000
Minar semiaxis S0000
Aniradrop) factar e
B Predicted ¥alue
~ * kit F36395.8
* L 4834523
. Valie 0.6500104
Weights (20 neighbors)
+ ® o

m

0.0z

———

T 1
0.95534 1.38

I I
T T
0.27503 0.584

[ < Back ][ Mext = ”

Finish

l [ Caniel

Click “Next”.
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The following step performs the Cross Validation and calculates the prediction error statistics —
Mean, Root-Mean-Square (RMS), Mean Standardized, Standardized Root-Mean-Square
Prediction Error (SRMSPE), and Average Standard Error (ASE).

Geostatistical wizard - Kriging step 5 of 5 - Cross Validation = @
S-:urT:e ID  Included Measured Predicted Error St Predicted
u] Yes 0.65 0.467... -0... 0. 1.38
1 Yes 0.15 0499, 0. 0.
2 ves 0.29 0.487... 0. 0. 1.258
3 Yes 0.72 0.474.., -0... D 1133
4 fes 0.47 0.540... 0. 0.
5 Yes 0.34 0.610... 0. 0. : 1.009
] Yes 0.56 0.483... -0... 0.
7 Yes 0.06 0.737... 0.... 0. 0288
5 Yes 0.65 0.741... a.. . . . *
3 Ves 0.6 079%.. 0. 0. 0762 [ pe ' f 9 * i
10 Yes 0,73 0744, 0. 0O *
11 fes 0.54 0.677.. -0... 0. 0E3s . L T
12 Yes 0.1z 0.755... 0. 0O: 055t - .
13 Vs 0.77 0620, 0. 0. I, *. ™ S LR .
14 Ves 0.65 0.675.. 0. 0. 039 e .
15 Yes 0.65 0.649... -0... 0. - *
16 ies 0.28 0782, O.. O 0.267
17 fes 0.65 0.730... 0. 0O:
18 es 0.08 0.573.. 0O.. O. 0144
19 Yes 1.2 0.435... -0... 0O:
20 Yes 0.73 0.5el.. 0. 0. 0.0z 0171 0322 0473 0EB24 0776 0827 1078 1229 138
21 Ves 0.08 0.69... 0. 0. Meazured
22 Ves 1.35 0617, -0, O Predicted 4 Ermor . Standardized Emor » Mormal QOPlot
23 fes 1.33 0.717.. -0... 0:
24 Ves 1.3 0.779... 0. 0. Regression Function |D. 196846447264345 ¥ =+ 0.4, | =
25 Vs 0.9 0.815.. -0. 0. Prediction Errors
26 Ves 1.01 0701, 0. 0. Samples 71of 71
27 ves 0.07 0.794... 0. 0. Mean 00122235 E
28 Ves 0.9 0.716... -0.. 0. Root-Mean-3quare 0.335861586
20 Ves 111 0.739... 0. 0. Mean Standardized 0.03051447
an Ves 115 n7El . . T Root-Mean-Square Standardized 0,957803
4 1 3 fverage Standard Error 0,3542786 -
< Back Hexdt = [ Finish | Cancel

Record these values in a table such as Error Stats Table.xls.

The |RMS-ASE]| is not calculated by ArcGIS, but can be set up to be calculated automatically as
it has in the given table. This value is used for comparing the accuracy of the models tested.

Click “Back” until you arrive at the “Geostatistical Wizard - Kriging Step 3 of 5 -
Semivariogram/Covariance Modeling” window, and change the model to “Exponential”. You
will notice the blue lines on the Semivariogram graph move slightly. The Major and Minor
Ranges and the Direction should all remain at the values that were entered previously.

11



Geostatistical wizard
Semivariogram

w107
2592

2,304
2018
1.728

1.44
1.152
0.964
0.575

n.zes

e

- Kriging step 3 of 5 - Semivariogram/Covariance Modeling

o 0T

Semivariogram map

= hiodel ¢ Binned < Averaged
todel : 0.082092 "M ugget+0 0637 25°E xponential[1 00000, 50000,90.0]

4.387

=[O =]

E General
Opkirize model [
Wariable Semivariogranm
E ™Model Mugget
Enable True
Calculate Mugget True
Mugget 0,08209226
Measurement Error 100 %
E ™Model #1
Type Exponential
Maijor Range 100000
Anisotropy True
Minor Range 50000
Direction a0
Calculate Partial Sil True
Partial Sill 0.06372515
Model #2
Model #3
8774  |E Lag
Diztance [Meter]. h-10 -4 Lag Size 73z
Mumber of Lags 1z
D.2592I
0216
01728
0.1236
0.0864
004325 -
UI
| % Back H Mext = ] | Einish | | Cancel

Click “Next” until you return to “Geostatistical Wizard -Kriging Step 5 of 5 - Cross Validation”
and record the error stats under the Exponential section of the table (the values in Step 4 should

remain unchanged).

Repeat these steps with the Gaussian model.

With the error stats for the three models entered into the Excel spreadsheet, the errors can be

compared between models, keeping in mind that:

The mean should be as close to 0 as possible,

The RMS and ASE should both be not more than 20,
The RMS and ASE should be similar, as calculated in the |RMS-ASE| column,
And the SRMSPE should be as close to 1 as possible.

Select the model that provides the most accurate interpolation (ie. the best error stats) and record
this in a new column in the table or simply highlight the model that has been selected within the

table.

12




Return to Step 3 of the Geostatistical Wizard, and click the model that you have just selected.
Click “Next” until you return to Step 5 and click “Finish”. In the “Output Layer Information”
window, ensure that all parameters are, in fact, correct.

i )

kethod Report @

Input datasets

B Datassat 1993 Ont_pts_edit_"1998_Ont_ptss’

Type Feature Class

Data field '1998_Ont_pts$'.HG

Records 71

B Method Kriging

Type Ordinary

Output type Prediction

B Dataset # 1

Trend type MNone

B Searching neighborhood Standard

Type Standard

MNeighbors to include 5

Include at least 1

Sector type Four and 45 dearee

Angle an

Major semizxis le+005

Minor semizxis 20000

E Variogram Semivaringram

Mumber of lzgs 12

Lag size 7312

MNuagget 0.10056529262786879

Measurement error %o 100

ShiftonN Mo

B Model type Spherical

Range le+005

Anisotropy ¥es

Minor range 20000

Direction a0

Partial sil 0.04275370210503935

| Save... | POk { | Cancel

Click “OK”. The prediction surface is now generated.



In the Table of Contents, move this new layer below the shoreline vector layer. Keep in mind
that this layer is temporary. Right click the layer and go to Properties. Under the Extent tab,
“Set the extent to:” “the rectangular extent of realdeal-utm17”. This will ensure that the Kriging
layer covers the extent of the shoreline vector. Click “OK”.

Fie Ede View Bookmats Ingent  Sefection  deoprocessing  Custormee  Windows  Melp

DEES L @R X 0~ & umm sl EEEED P 0P g Gomumeal nare e g 80 SN R0 B 0 e - :.'_':'-".Sh.ﬁﬁ
VAl L e I Yl

v il et

[0 8

O Lagens
= B 1998 Ont_pts_edt
.
= B ontario_slip
14 B reakdeatamt?
(=]
= B Higing
Prediction Map
11ROt e edit 1980 nt_ptF]1'1989_ 0
Fited Cankours
[ LUREGEEE
B 0LL0526A108 - 0195203002
W R195IRATLY - A HEARLESL
R TIARIST - 0 ADSETEAG
BANSIELE - R5135RI04Y
LSNISEIHE - RETITERLSY
B EPOTSENAT - QEXIATITE
I LMETIT - 15900195
590018295 - LIPS
LTS0S0 106

: 3
Fiw

Wy e ﬁ'\

i J ViEme | e ” Iy
SHIINEIT 4ESIRIT0TR Metert.
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Adjusting the symbology of the Kriging layer

Double click on the Layer Name of the Kriging layer to open the properties window. Click the
Symbology tab, and then click on “Filled Contours”.

i

Layer Properties

Shiow:

[ Hillshade
|:| Caonktours

[ arid

Filled Contours

] (3]

-

A A&

| General | Source | Diizplay | E:-:tent| Symbology | b ethod Summar_l,l|

7l

Draw surface as filled contours

Color Ramp: B

i -

Syrnbol

Range

P 0.0z - 0.103265708

[ 0.103268703 - 0.195289212

0.195289212 - 0,296951351
0,296951351 - 0.409361644
0.409351644 - 0.533553449
0.533553449 - 0.670795192
0670795192 - 0,322467776
0.8322467776 - 0,990073295

P .990075295 - 1.17530519

| BREESCEE:

Label

0.02 - 0.103268705
0.103265705 - 0.195259212
0.195289212 - 0,296951351
0.296951351 - 0.409361644
0.409361644 - 0553553449
0.533553449 - 0.670795192
0.670793192 - 0.822467770
0.322467776 - 0,990073295
0.990078295 - 1.17530519
1.17530519 - 1.33

Classification bype: Geometric Interval,

Presentation quality

[ refine on zoom

Display MODATS as:

10 - classes

| oK

][ Cancel ][

Apply

Check the “Presentation Quality” box, and then click on Classify to open the Classification

window.
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Classification
Histoagram

Court 1071
1.3

1182

1.064

0.345

0827

0,703

0.59

0.473

0.355

0.236

n11s
0

0.0z

0214

0.403

0.603

0.797

0.99

1.186

1.38
Walue

-

=)

E Classification
tethiod Geometric [ntery. ..
Clazzes 10
Cusgtom Min and ... | Falze
EH Graph Froperties
Bars a
E Data Exclusion
Lower threshold  Symbalize bo first..
pper threshold — Spmbolize ta last..
E Breaks

[kdir] noz

clazz #1 01032687
class #2 01952332
clazz #3 02969314
clasz #4 04093616
clazz #5 05335534
clazz HE 0707332
clasz #7 08224673
clazz #8 0.9900733
clazz #3 1.175305
[hd am] 1.28

Statistics

[ QK ] | Cancel

Change the Classification Method to Manual, and adjust the number of classes (“Classes”) to
however many are necessary. This will be determined by the minimum and maximum values
and the intervals that are used. In this example of mercury, the intervals will be based on the

values of the TEL (0.174) and the PEL (0.486). There will be 3 equal intervals below the TEL, 3

equal intervals between the TEL and the PEL, and 3 intervals (based on the ranges between the
TEL and the PEL) above the PEL. Therefore there will be 9 custom classes, corresponding to
those found in Colours.xls. Adjust the breaks (on the right side) to incorporate the necessary

intervals.
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Classification @
Histagram H Clazssification
1 ethod Marual
Count-10 Clazzes 9
13 Custom Min and ... Falze
1182 E Graph Properties
Bars S
1.064 E Data Exclusion
Lower threghold  Symbolize to first...
0.345 Ipper threghold  Symbolize to last...
0.827 = Br.eaks
] [kin] 0.0z
0709 clazz #1 0.0538
clazs #2 0116
0.591 class #3 0174
0.473 clazs H4 0273
clazz #5 0382
0355 clazz #E 0.486
clazs #7 059
0.236 class #8 0.654
0113 [hax] 1.38
; Statizhics
0oz 0214 0409 0603 0797 0991 1186 1.38
Walue
| ok | Cancel

Click “OK” in the Classification window.

In the Layer Properties window, Click and check off “Contours” on the left side of the window.

Both “Contours” and “Filled Contours” should be checked off.

As with the “Filled Contours”, check the “Presentation Quality” box.
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Layer Properties

| General | Source | Dizplay | E:-:tent| Symbology | kethod Summar_l,l|

-7 el

Shiow:
[] Hillshade
Caontours

[ Grid
Filled Contours

] (3]

M

e

| Draw surface as contours

Color Ramp: -

- - Classify. .,

Symbol  Range

0.103265708
0.195289212
0.2969531351
0.409351 644
0.533553449
0.670795192
0.522467776
0, 990075295
1.17530519

Label

0.103268705
0.1952589212
0.296951351
0.409361644
0.533553449
0.670795192
0.522467776
0990075295
1.17530519

Presentation quality
[] refine on zoom

Classification bype: Geometric Interval,

10 - classes

][ Cancel ][

Apply

Click on the “Classify” button to open the Classification window.
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Classification @
Hiztogram E Classification
1 b ethod Geometric [ntery...
Count 10 Clazszes 10
1.3 T 7 T T T T T Cuztam Min and ... | Falze
1182 EH Graph Froperties
Barz a
1.064 E Breaks
[kdir] noz
0.343 class #1 0.1032687
0,627 clasz 2 01952892
claszz #3 02969314
0709 clasz #4 04093616
clazz #5 [.5335534
0.591 class HE 0.6707982
0,473 clazz #7 08224678
clazz #8 09900733
0355 claszz #3 1.175305
[k am] 1.28
0236 Statistics
0118
1]
noz 0214 0403 0803 0797 0931 1.186 1.38
Walue
£ ok, [ Cancel

If the range of values encompasses both the TEL and the PEL values, change the number of
classes to 3. If the range of values includes only one of the TEL and PEL, change the number of
classes to two. In the case of mercury in Lake Ontario, both TEL and PEL are included.

Change the Method the manual, and change the “Breaks” values to equal the TEL and PEL
values:
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Histoagram

Count-10 1
1.3

1182
1.064
0.345
0.827
0.¥09
0.591
0.473
0.355
0.236

n11s

0
0.0z

0214

0.403

0.603

0,737

0.391

1.186

1.38
" alue

Click “OK?”, and return to the Layer Properties window.

bl ethiod

b aral

Clazzes

3

Custom Min and ...

[Mir]

Falze

claszz #1

classz #2

[k ]
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| Generall Sourcel Displa}ll E:-:tentl Symbology | tethod Summar}ll

Layer Properties

Shio: | Draw surface a: contours

[ Hillshade Color Rarmp: - - - Classify. ..

Conkours

[ arid Symbol  Range Label
Filled Contours 0,174 0.174
— 0,436 0.43&

E3ra

Classification type: Manual, 3 - classes

Presentation quality
/\\ /\ [T refine on zoom

——m

[ ar. J[ Cancel ][ Apply

l

Adjust the colours of these two lines. Double click the line representing the TEL (0.174, in this
case), and change its colour to green (Medium Apple, to be precise). Do the same with the PEL

(0.486) and make it red (Mars Red).

| Generall Sourcel Displa}ll E:-:tentl Symbalogy | Method Summar}ll

Layer Properties

Shio: | Draw surface as contours

[] Hillshade Color Ramp: - - - Classify. ..

Cantours

[ arid symbol  Range Label
Filled Contours 0174 0,174
— (406 0.486

EIra

B

Classification type; Manual, 3 - classes

Presentation quality
f\ /_:}' [T refine on zoom

[ 0k J[ Cancel ][ Apply
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Layer Properties @
| General I Sourcel Digplay | EHtentl Spmbology | Method Summar_l,l|
Show: | Draw surface as filled contours
c :H - Classify...
Contours
7] arid Symbol  Range Label
Filled Contours B oo -ose 0.02 - 0.058
P oss-outte 0.053 - 0,116
0.116-0.174 0.116-0.174
0.174 - 0,275 0.174-0.275
0,275 - 0,382 0.275 - 0.3582
0,382 - 0,456 0,382 - 0,486
0.486 - 0.59 0.486 - 0.59
P 050 -0.es4 0,59 - 0,694
| N 0.694 - 1,38
Classification bype; Manual, 9 - classes
P Lati lit
ressntation qualty Display NODATA as: |
"] refine on zoom

[ (] J[ Cancel ][ Apply ]

Adjust the colours for the filled contours as well. Click Filled Contours on the left menu. Based

on the RGB colour settings found in Colours.xls, adjust each of the classes accordingly by

double-clicking on the colour symbol. Under Fill Colour in the Symbol Selector window, select

More Colour. In the new window, Colour Selector, change to RGB (in the top right corner),
which will allow for the accurate input of the desired RGB values.

Layer Properties

Shiowa:

[ Hillshade
Conkours

7] Grid

Filled Conkaours

(2|

| General I Source I Display I E:-:lenl| Symbology | Methad Summar_l,ll

| Draw surface as filled contours

Color Ramp:

B

Symbol  Fange

0,02 - 0,058
0,055 - 0,116
0,116 - 0,174
0,174 - 0,275
0,275 - 0,332

R

B 56050

| EERET

[ R

Label

0.02 - 0,058
0058 -0.116
0116 -0.174
0,174 - 0,275
0,278 - 0,382
0,382 - 0,486
0486 -0.59
0.59-0,694
0,694 - 1,33

Presentation quality
[T refine on zoam

Classification type: Manual, 9 - dasses

Display MODATA as: |

[ QK ]’ Cancel ] Apply
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Alternatively, if a greyscale map is desired, while in the Colour Selector window, click the right-
facing arrow in the top-right corner and click “Advanced Selection”. Click the drop down menu

at the top, and select Gray. The desired grayscale value can then be entered for the class (also

found in Colours.xls).

i

Layer Properties

-2 ]

| General | Source | Diizplay | E:-:tent| Symbology | b ethod 5ummar_l,l|

Shiow
[ Hillshade
Contours

[ @rid
Filled Contours

A Ca

| Draw surface as filled contours

Coor R o -
Symbol  Range Label

0.0z - 0.058 0,02 - 0.058

0.058-0.116 0,058 - 0,116

0.116-0.174 0,116 - 0,174
[ 740278 0,174 - 0,278
P ozvs-032 0,278 - 0.382
[ KRS 0,382 - 0.486
B o050 0,486 - 0.59
[ R 0.59 - 0.694
[ TR 0.694 - 1,33

Presentation guality
[ refine on zoom

Classification type: Manual, 9 - classes

Display NODATA as;

[ ] J[ Cancel ][ Apply
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Click “OK” in the Layer Properties window. The ArcMap window should now look as follows
(using the colour scheme and ranges in Colours.xlIsx):
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Table Of Contents %
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= B 1898 Ont_pty_edt
.

B ontario_slip

11959k pts_edit,'1988_ Ot _pte§'] 195901
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Creating the Vector Shapefiles

Since all predictions made outside of the lake are unnecessary, the vectors must be created from
the Kriging layer, then cropped (which is where the ontario_clip.shp layer comes into play).

First, right click on the Kriging layer, and select Data = “Export to Vector...” and the “GA
Layer to Contour” window will pop up.

"\ GA Layer To Contour E’

-

Input geostatistical laver

IKriging LI @

Contour bype

FILLED COMTOUR, -
Qukput Feature class
SihaurnmerworkiHG_ _vectar .shp %
Contour quality {optional)
PRESEMTATION -
[ Ok, ] [ Cancel ] [Envirnnments... ] [ Show Help ==
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Change the “Contour Type” to Filled Contour, and ensure that the new shapefile will be exported
to the proper folder and with the right file name (current convention is to name the file
“HG_vector”). Change “Contour Quality” to presentation, and click “OK”.

After the vector layer is added to the display, right click the layer, go to Properties - Symbology

and click “Features” on the left side. Click Apply, then OK, and the ArcMap window should
look as follows:

O rrecciry Krrgra i - Bechig < el =1
Fie  Ede View Bookeaeks Ingemt  Selechon  Geoprocesing  Customme  Windows  Help

® - - 111 = s EEEE D P V7 5 Geambite inshats G 2 1 =1 8

Takd ]
2= Bl R

Lagmie

B 1998 Ont_pts_edit
.

B Hivectar

B entaio_clp
=]

B realdest-utml
=]

a1 _edit195 Ot _pto¥ ] '1958_0r |

Next, you want to get rid of all data outside of the lake. You can accomplish this by using “Clip”
in the ArcToolbox:

Select the ArcToolbox = Analysis Tools = Extract = Clip
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& ArcToolbox
ﬁ 3D Analyst Tools
E@ Analysis Tools
-y Extract

Lo

..... %, Clip

----- . %, Select

L %, Table Select

- Overlay
- B Proximity
-8 Statistics

=+

The input layer to clip is the one that was just created, HG_vector; the “clip features” is
ontario_clip. Write this file to the same folder as HG_vector, calling it HG_vector_clip, for
example. Leave the XY Tolerance empty, which is the default.

. ciip =5 Fen <~

Inpuk Features

| HG_vector j

Clip Features

||:|r1tari|:|_clip j

Cutput Feature Class

S SummerWorkiHG_vector_clip.shp
%Y Tolerance (optional)

Meters b ]

Ik ] [ Zancel ] [Envirnnments... ] [ Show Help ==

Click “OK”

Remove the HG_vector.shp layer. The map should now look as follows:
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To create the isolines, right click on the Kriging Layer Name, select Data - “Export to
Vector...”, but this time, leave the “Contour Type” as Contour (as opposed to Filled Contour
previously).

Change the filename to HG_Isolines.shp (as has been used in all analyses thus far), ensuring that
the file is being written to the proper folder. Change Contour Quality to Presentation. Click
“OKii.

Again, the data outside of the lake must be deleted. Select the clipping tool. The input feature is
now HG_Isolines, and the “clip feature” remains ontario_clip. Change the filename to
HG_Isolines_clip.shp, ensuring it is written to the right folder.

Click “Finish” and remove the HG_lIsolines layer from the Table of Contents.

The map should be as follows:
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The Kriging layer can now be unchecked in the Table of Contents, making it invisible. The file
of the shoreline vectors should be moved to the top of the list in the Table of Contents.

The symbology of these two new layers must now be adjusted.
Double click on the HG_Isolines_clip layer to open Layer Properties. Go to the Symbology tab.

Click “Categories” on the left side of the window. Change the “Value” field from Classes to
Value and click the “Add All VValues” button at the bottom of the window. In this case, only the
PEL isoline appears, because all TEL values lie outside of the lake. Double click on the line, and
change its colour to red (Mars Red) (or Medium Apple [green] if it is the TEL isoline). Uncheck
the “<all other values>" box.

Click in the Label field of the value, and change it to “0.486 ug/g (PEL) Isoline”. These values

will vary, of course, depending on the contaminant, and whether or not the value is the TEL or
the PEL.
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Layer Properties @
Joing & Relates I Time | HTHL Popup
General I Source Selection I Dizplay | Syrbalogy Fields Visibility I Fields | Definition Cluesny | Labels
Shiowr - - - -
Features Draw categories using unique values of one field.
Categories Walue Field Color Ramp
Unigue values Walue - -
Urnigue values, many
i M atch to symbals in 2
Quantities Symbol  Walue Label Count
Charts [] <all ather values: <&l ather values: n
Multiple Attributes ¢Heading> Yalue 1
0.486 0,486 ug/g [PEL] lzoline 1
4 m | 3
Add &l Values ] [ Add Values... ] [ Remove ] [ Remove Al ] [ Advanced -
Ok ] [ Cancel ] [ Apply

Click “OK”
Open the Layer Properties of the HG_vector_clip layer, and go to the Symbology tab.
Click “Quantities” on the left side of the window, and in the Fields box, change the value field to

“Classes”. If there are classes that are grouped together when this is done (a likely scenario),
simply increase the number of classes in the “Classification” box within the Symbology tab.
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Layer Properties @

Joing & Relates I Time I HTRL Popup
General Source Selection | Dizplay | Symbalogy Fields Yisibility | Fields I Drefinition Guery I Labels
Show:

Features Draw quantities using color to show values.

Categories Fields Clagzification
Quantities W alue: Claszes - Matural Breaks [Jenks]

P Graduated colors .
- Graduated symbols Marmalization:  none - Clazzes: & = Clazsgify...

Propaortional syrbols

Lo Dt density Color B amp: - -
Charts
Multiple Attributes Symbol  Range Label

= e e ) R

[ Show class ranges using feature values Advanced -

(] 4 ]’ Cancel ][ Apply

The classes must now be labeled.

To determine the value that each class represents, refer to the original Kriging Layer that was
created. Keep in mind that the numbering of classes in the Kriging layer begins with 0.
Therefore, class 3 in the HG_vector_clip represents 0.174 — 0.278 ug/g. Label each class “0.174
- <0.278” — “0.278 - <0.382” since it is always the lower break that is correct. Keep in mind that
the number of classes in the clipped file may not be the same number as in the Kriging layer
since some of the classes in the Kriging layer may be found exclusively outside of the lake, and
therefore not included in the clipped vector layer. Make sure to adjust the colours accordingly to
those found in Colours.xls.
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Layer Properties @
Joinz & Relates I Time I HTHL Popup
General I Source Selection I Dizplay | Symbalogy Fields Yisibility | Fields I Drefinition Clueny I Labels
Shiow — -
Features Draw quantities using color to show values.
Categories Fields Clazzification
Quantities Walue: Clazzes - Matural Breaks [Jenks)
----- Graduated colors }
----- Graduated symbols | Normalization: none hd Llagses: B
i Proportional symbolz
----- Dot denzity Color Barnp: _ -
Charts
Multiple Attributes symbal - Range Label
3 0174 - <0278
4 0278 - <0382
0382 - <0486
0486 - <059
059- <0694
»=[1694
[7] Show class ranges using feature values
(] ] [ Cancel ] [ Apply

Click on the “Symbol” column heading, and select “Properties for All Symbols”. Change the

“Outline Width” to 0.
Click “OK”.
Click “OK” in Layer Properties.

The map should now look as follows:
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Click on the heading of the HG_vector_clip layer (where it says “Classes” right below the Layer
Name), click again, and change the heading to “Prediction Intervals (ug/g)”

**|t is important to remember that when working with trace metals, measurements are in ug/g,
but with everything else (organochlorines and PAHSs) measurements are in ng/g.

You’re finally ready to start preparing the actual layout.
Preparing the Layout

The points shapefile layer can be unchecked, as it will not be included on the final map. Click on
the layout button to the bottom left of the map.

Change the page layout to landscape by clicking File = Page and Print Setup, then click
“Landscape” in the middle of the window. Click “OK”.

Right click on the data frame (the frame where the map is), select Properties, and go to the Size

and Position tab. The position and size coordinates should be as follows (ensure that the centre
anchor point is selected):
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i )

Data Frarne Properties @

General | Diata Frame | Coordinate System I Ilurnination | [Gnids |

Feature Cache | Annotation Groups | Eutent Indicators | Frame | Size and Position
Pozition Size
= 5.5in "width: B.7555 in
i 45124 in Height: 32838 10n
[] Az Offzet Distance [] Az Percentage
Anchor Point; [ Preserve Aspect Ratio
o O O
Element Mame
] 8] ]
Layerz
8 O O
0k, ] [ Cancel ] [ Apply
Click “OK”

On the Standard toolbar, change the zoom to 1:2,009,129.
Using the Pan tool (on the Tools toolbar), the map may need to be moved slightly.

So far, the layout should look like this:



=T

Fiw Ede View Bookmarts Ingemt Sefection  deoprogesing  Customaze  Windows  Help
DEd& B x o~ & 2 =3 EEEE O P 7 Geambinic st e VMDD DR WEs - DEKDY
REMQ I e - 0] LN i
Table 0f Contencs ok __ T Tt S I FST 1R s I s L iiiiaciiss . . I L A— [ ]
[Hasm g
s & s

= B realdeshutmll =

=] -

O 1558_0nt_pts_edit 3

3 ]

= B MG isolines_dlip
Walue

— L.496 ugly (PEL) Lraline
= [ M. isolines

11958 Ont_pes_adit'1958_ Om_ptsf')1' 2998 O |
Contours 3
BN

—haE
Filied Conbours
B2 - 0050
RU5E - 136
BN BT
niRe- 01TE

CTYU MY

L TR

-G L5

L TERT

[ LTI

dljaE & .
134T 103 Bchey

Go back into the Data Frame Properties (right click on the data frame and select Properties), and

go to the Grids tab.

Click the “New Grid” button. Select Graticule, then “Next”.
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i )

Grids and Graticules Wizard @

N JEN— R Which do vou want to create?

T

@ Graticule; divides map by mendians and parallels

T =

TS (") Measured Grid: divides map into a grid of map urits

T

(7 Reference Grid: divides map into a arid for indesing
e

Irs

Irs

Grd name:  Graticule

¢ Back [ Mest = ][ Cancel ]

In the Create a graticule window, select “Labels only” and change the Intervals to 1 degree for
both parallels and meridians.

35



i

Create a graticule

TS'OO E2°O00 3TN 36°m

Appearance

Style:

() Tick marks and labels

() Graticule and labels

Interyals
ODeg  Min Sec
Place parallelz every 1 0 0 latitude
Place meridians every 1 0 0 longitude

< Back ][ Mest » ][ Cancel

Click “Next”.

In the Axes and labels window, change the “Number of ticks per major division” to 2.

Aues and labels

TS'OON G200 A T 36 O

2]

Line style:

—

Line style:

Minar division ticks E

Mumber of ticks per major division: 2

Labeling

¢ Back ][ Mest » ][ Cancel
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Click “Next”.

Select “Place a simple border at edge of graticule” and click on the button below to adjust its
properties. Change the width of the line from 1.5 to 0.5.

i )

Create a graticule @

Graticule Border

SOOI B2°OON @ oo 35mi

@ Place a simple border at edge of graticule

—

(") Place a calibrated border at edge of graticule

Properties. .
M eatline

[7] Place a border outside the grid

Graticule Properties

() Store &z a static graphic that can be edited

& Store as a fiwed gnd that updates with changes to
= the data frame

< Back ][ Einizh ] [ Cancel

Click “Finish”.

In Data Frame Properties, Click “OK”.
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The title, legend, scalebar, and north arrow can now be added.
To add the title, go to Insert - Title
Change the title to, for example, 1998 Lake Ontario Mercury Concentrations. Click “OK”.

Double click on the text to open the Properties window. In the Text tab, click the Change
Symbol button, and change the font to Times New Roman 18pt bold. Click “OK”.

Go to the Size and Position tab, ensure that the central Anchor Point is selected, and change the
X and Y Position coordinates to X: 5.5, Y: 6.63.

Click “OK”.
To insert the Neatline, go to Insert > Neatline. In the Neatline window, select “Place inside

margins” and ensure that the “Gap” is 10 pts. Change the “Background” colour to “Hollow”
using the dropdown menu. Click “OK”.
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[ Meatline @

Flacement Border
Flace around zelected element(z] E|
Place around all elements L£]
@ Place inzide margins e
Create separate neatline element E|

Group neatling with elerment(z]
Drop Shadow

[ap: Bounding: ——
10.0= pts 0= % |E|

|gdvanced... [ ak ]| Cancel |

To insert the scale bar, go to Insert = Scale Bar. In the Scale Bar Selector window, click
“Alternating Scale Bar 2”.

Click the “Properties” button in the Scale Bar Selector window.
In the “Units” box in the Scale and Units tab, change the “Division Units” to “Kilometers”. In
“Label” change “Kilometers” to “Kilometres” (we are Canadian, after all). In the “Scale” box of

this window, check off the “Show one division before zero” box, and change the “Number of
divisions” to 2 and the “Number of subdivisions” to 4.

Go to the Format tab, and change the font to Times New Roman

Click “OK”, and “OK™ again in the Scale Bar Selector window.

39



[ scale Bar @

Scale and Urits | Numbers and Marks | Fl:nrmat|

Scale

Auko
Murnber of divisions: 4=
rumber of subdivisions; 4 =

| Show one division before zera

When resizing. ..

|F'.|:|just division value - |
Units

Division Units:

| Kilometers - |

Label Position:

|aFter bar v|
Label:  Kilometres Syrmbal, ..
Eap: Ipt =
[ 2k ] | Cancel | | Apply |

Click the scale bar and drag it to below the data frame.

With the scalebar selected, adjust the width until the major division (on the right) is 50 km by
clicking and dragging the box on the middle right or left. @ o mmmg

I T

@j £ 0 | =k a
Double click on the scale bar to open the “Alternating Scale Bar Properties” window. Go to the
size and position tab, and change the Position coordinates to X: 7.2, Y: 2.45, ensuring the central
Anchor Point is selected. Click “OK”.
To insert the north arrow, go to Insert = North Arrow. Select “ESRI North 1” and hit “OK”.
Double click on the north arrow to open the North Arrow Properties window. In the Size and
Position tab, change the position to X: 8.7, Y: 1.9, again ensuring the central Anchor Point is
selected. Click “OK”.

The layout should now look as follows:
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Adding the Legend
To put the legend in, go to Insert > Legend.
Remove all items in “Legend ltems” by clicking the button.

In “Map Layers” select HG_vector_clip and hit the button to add it to “Legend Items”.
Do the same with realdeal-utm17 (the shoreline vector — don’t ask about the naming), and
HG_isolines_clip. Change the “Set the number of columns in your legend” to 3.
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Legend Wizard @

Chooze which lavers you want to include in vour legend

tap Layers: Legend tems

- realdeal-utm17 HG_wectar_clip @

realdeal-utml7
HG izalines clip

- HG_izolines_clip
- HG_wector_clip
-+ 1938_0nt_ptz

- Kniging

- antario_clip

- HGE_izolines

- HGE_wectar_

Set the number of columnz in vour legend: ]

Preview

< Back Mest » ] [ Cancel

Click “Next”

In “Legend Title font properties” change the “Size” to 12, the font to Times New Roman, and
make it bold and underlined.



Legend Wizard @

Legend Title

Leqgend

Legend Title fant praperties Title Justification

Colaor: . = .
'ou can use this ko

contral the justification
Size: 12 - of the title with the rest
of the legend.

Fant: Ia] Times Mew Faman -

7 (4]
Presyview

| < Back H Mest » ]| Cancel |

Click “Next” until you get to the final window of the Legend Wizard, and finally click “Finish”

Move the legend to below the dataframe, and not on top of the scale bar or north arrow. The
legend should currently look like this:

Legend i
HG vector_clip I 0382-<0486 [ | realdeal-utm17
Prediction Intervals {ugig) - 0486-<059 Value
0.174 - <0.278 B o0s9- <0634 ——— 0486 ug/g (PEL) Isaline
0.278 - <0.382 B =0 604 H

Double-click the legend to open the Legend Properties window. Under the “Items” tab, make
sure each Legend Item has the “Place in a new column” box checked, and the “Columns:” for
each is set at only 1 (both at the right of the window). In Legend Items, double click on
HG_vector_clip, opening the Legend Item Selector window. Click the “Properties” button.
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In the General tab, deselect “Show Layer Name”. Click the “Heading Symbol” button, and
change the font to Times New Roman 10 pt bold, and click “OK”. Click the “Label Symbol”
button, and change the font to Times New Roman 10 pt, and click “OK”. Click “OK” in the
Legend Item window, and “OK” in the Legend Item Selector window, returning to legend

properties.

Double click realdeal-utm17 in Legend Items. Using the same process, ensure that only “Show
Labels” is selected and change the Label Symbol to Times New Roman 10 pt.

Do the same for HG_Isolines_clip.

The legend should now look like this:

]
Ilegend
Predicton Intervals (ugig) | | realdeal-utm17 0.486 uglg (PEL) Isoline
0.174 - <0278
0272 - <0382

D 038z - <0486
B o6 - <050
| PR

_ ==0) 04 ;

In the Table of Contents, click the Layer Name of the realdeal-UTM17 layer and change it to
“No Data”. This provides the No Data symbol for the legend — a kind of round-about way of

doing things, but it works...

Check to make sure that everything in the legend is correct — prediction intervals, labels, etc. and
make any changes necessary.

Once the legend is correct, right click on it and click “Convert to Graphics”. Right click on it
again and click “Ungroup”.

The legend should now look like this:
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You will want to use 4 rows of symbols (5 if there are a lot of classes). What you will need to do
to properly organize the legend is first, move the No Data and Isolines out of the way for the
time being by selecting and dragging them.

Next, in this case, you will want to move the fifth class, 0.8 -<1.0 to the top of the second
column. Next, move No Data under the 0.8 - <1.0 class, and the isoline(s) below this (it may be
necessary to have more than two columns, depending on the number of classes and isolines):

Legend
Prediction Intervals (ug/g)

0174- <027z [ 059 - <0694
0275 - <0332 [ =094

I 03s2-<0.436 | | NoData
0O

|
B 0436 - <050 0.436 ug'g (PEL) Isoline,

To ensure that all the items are properly aligned vertically, use the Y coordinates from items in
the left column and copy and paste these page coordinates to those in the other columns. For
example, to ensure alignment of the Isoline, in this case, double click on [l 0.486 - <059
opening the Properties window, highlight and copy the Y Position coordinate, ensuring that the
Anchor Point is centred vertically. Close down this Properties window (hit “Cancel”) and
double click the Isoline item, opening its property window. Highlight the Y Position coordinate
and paste the new one (from [l 0.466 - <050 ). Hit “OK”. Repeat this for all remaining
items.

To ensure the proper spacing of columns, open the Properties window of the longest item in the
left column. Select right-central Anchor Point:

Anchor Point:
Add 0.2 inches to the X Position Coordinate - - N
(ie. 3.281592” in becomes 3.481592”). Copy e
this coordinate, and hit “Cancel” in the o @] (8]
Properties window (you don’t actually want to 0—0o—0
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apply this change to this legend item). Open the first legend item in the column to the right,
change the Anchor Point to the left-central point. Paste the coordinate that you copied from the
left column to the X Position coordinate of this item. Repeat this for all legend items in this
column. If there are more than two columns in the legend, these steps will need to be repeated.

Select all legend items, right click, and select “Group” to group them back into one element (this
ensures that no items will be accidentally moved relative to each other).

Tegema i

Prediction Intervals (uz/g)

i 0174 <0272 [ 059 - <0604
; 0272 -<0322 [ =0604
W 03:2-<0486 [ [NoData

0.4%6 - <0.59 0.426 uglg (FEL) Isoline.

Double click on the legend, opening its Properties window. Change the Anchor Point to the top
left, and change the X Position coordinate to 2.122244 in (aligned with the left extent of the data
frame), and the Y Position coordinate to 2.5. Click “OK”.

At this point, you will probably want to save your work (since the layout is now complete) if you
haven’t done so already.
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Go to File > Save (or Save As)...you know the rest...

This will save it as an .mxd file, so your layout and attributes will all be saved.

Advanced Layout

These Position coordinates will change, depending on the size of the map that is being produced.
Generating these coordinates is not an easy task, and requires a lot of trial and error to achieve
the proper size and layout of everything.

The sizes that have been produced already are 11.5cm, 13cm, and full page (ie. for Powerpoint
presentations).

To change maps to the 11.5 cm or 13 cm sizes, the full page map must first be produced.
Change all of the Position Coordinates and sizes (“Width” and “Height” in the Properties
windows) to those included in FullPageXY .xIs.

With full page maps made, the first step in making 11.5 cm or 13 cm maps is to change the page
layout to portrait (File > Page and Print Setup...). Delete the neatline. Then, select all of the
elements on the layout (title, dataframe, legend, north arrow, scale bar), right click and open the
Common Properties for All Elements window. In the Size and Position tab, change the “Width”
to i.) 4.2” for the 11.5 cm, or ii.) 4.75” for 13 cm.

Deselect all elements, and go into the Data Frame Properties window. Click on Grids, and click
“Properties”. Go to the Labels tab, and at the bottom, in the Label Orientation box, check off
Right and Left. Hit “OK” and “OK”.

With this done, change all Position coordinates and sizes to those in 11-5cmXY .xls and
13cmXY .xls.

It is important to keep in mind that when you reopen mxd’s, ArcMap often likes to slightly move
the layout positions of the scale bar and north arrow. Check to make sure that these are correct
before producing anything for publication.

To export maps as JPEGs or TIFFS, when in layout view in ArcMap, go to File > Export.
Select the file type. Click the “Options” button and change parameters as necessary (ie. if
creating a JPEG, using a minimum quality of 200 dpi).

In some cases, you may need to manually alter the colours of the vector files (especially when
comparing data with different years or lakes). Some of these colour schemes have already been
generated, and can be found in Colours.xls. To manually change the colours, click on the
symbol that you want to change in the Table of Contents. This will open the Symbol Selector
window. Click the Fill Colour dropdown menu, and click “More Colours” at the bottom. Adjust
the RGB values accordingly.
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For the Isolines, if producing B&W maps, change the PEL isoline to a solid black line by
clicking on the line in the Table of Contents, opening the Symbol Selector window. Change the
colour to black, and ensure that the Width is 1. For the TEL, change the symbol type to “Dashed
4:4” (you will need to scroll down through all of the symbols in the Symbol Selector window to
find it). Change the colour to black and width to one.

Log Transformations (read all sections before performing)

Log transformations are necessary when the value of the ASE is greater than 20. There is more to
it than this but the previous statement can be used as a general rule. When the ASE is greater
than 20, actual prediction values stray quite far from the original input values. To do the log
transformations, do not use the log function within ArcMap. To do them, open up the .dbf file
of the point data in SPSS.

*Use the original file, not the file with the missing values removed made in Preparing the Data.

In the Data View of SPSS, click on Transform - Compute Variable.... In the “Target Variable”
box, enter a new variable name (ie. HgLog). In the functions, find “LG10” (found under
Function Group: Arithmetic). Double click, and the function “LG10(?)” will show up in the
“Numeric Expression” box, with the question mark highlighted. Replace the “?”” with the
variable that you want to perform the transformation on (double click the variable from the list in
the left of the Compute Variable window).

Click on the “If...” button, and in the new window check off “Include if case satisfies
condition:”. Double click the variable that you are performing the transformation on, entering it
into the expression box. Type in “<> -1”. *Ensure that there is a space between ‘<>" and “-1"*.
Click “Continue”. This will stop SPSS from trying to log a negative value which, of course, is
impossible.

In the Compute Variable window, click “OK”.
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All of the new values will be input to the new variable that you defined, “HgLog”. However,
there will be some blank spaces where there was a -1 in the original data. Fill in these spaces
with -1s so that when you perform the kriging analyses on the data, these points will be omitted
from the analyses. However, ensure that the points that had original data values of 0 (and not
missing values) are returned to 0, and not counted as missing values (-1).

Also...when doing log-transforms, you need to do the following....

Missing values must be assigned (-1 or -9999) where the original data points have a value of 0.
Reason: you can't log 0, so this will allow them to be omitted from the transformation. In some
cases where a lot of 0’s are in the files....there may not be enough points left to do a kriging
analysis on the log-transformed data.

Note: -1 is the number for missing values in the contemporary Erie and Ontario datasets....-9999
is used in all other files.
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Click on File - change the type to .dbf, and overwrite the original dbf. It may be necessary to
repeat the steps in the Preparing the Data section found at the beginning, since loading the
original .dbf into ArcMap may result in the missing values being reverted into zeros, rather than
blank cells. After performing the log transformation on the selected contaminant(s), repeat the
steps in Preparing the Data before performing the kriging analysis.

When running the kriging analysis, be sure to remember which log values represent which non-

log values so that the legends can be altered as necessary, i.e. log numbers would be represented
by their non-log equivalents in the map legend.
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